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Why Secure Spreadsheets? 
 
 
“As users of spreadsheet applications such as Microsoft Excel

®
 or Lotus 1-2-3

®
 have become 

more sophisticated, so have spreadsheets.  Once used to support simple functions such as logging, 
tracking and totaling information, spreadsheets with enhanced formulas and built-in advanced 
features are now used to support such business functions as complex valuation models.  The use 
of macros and multiple spreadsheets which are linked together allows users to build very 
complicated—and sometimes convoluted—models and other business functions with minimal or 
no documentation.  In addition, these complex spreadsheets are not normally supported by the 
same control environment as formally-developed, purchased applications.  For example, the 
developers and users of spreadsheets are usually not trained in structured programming; testing, 
version control or systems development life cycles, and spreadsheets are rarely restricted from 
unauthorized access by security controls.1” 
 
 
 
 
 
“When evaluating the risk and significance of potential spreadsheet issues, consider the 
following: 
 

▪ Complexity of the spreadsheet and calculations 
▪ Purpose and use of the spreadsheet 
▪ Number of spreadsheet users 
▪ Type of potential input, logic, and interface errors 
▪ Size of the spreadsheet 
▪ Degree of understanding and documentation of the spreadsheet requirements by the 

developer 
▪ Uses of the spreadsheet’s output 
▪ Frequency and extent of changes and modifications to the spreadsheet 
▪ Development, developer (and training) and testing of the spreadsheet before it is utilized1” 

  

 
1 From PriceWaterhouseCoopers whitepaper on spreadsheets 
http://www.pwc.com/images/gx/eng/fs/insu/rt5.pdf 
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What Constitutes Sensitive Data? 
 
Sensitive information is defined in SPG 601.12 as information whose unauthorized disclosure 
may have a serious adverse effect on the University’s reputation, resources, services, or 
individuals.  Information protected under federal or state regulations or due to proprietary, ethical, 
or privacy considerations will typically be classified as sensitive.  Sensitive information includes 
personally identifiable information such as protected health information (PHI), social security 
numbers, credit card numbers, and any other information designated as sensitive by the 
University Data Stewards 
 
Sensitive data will differ by department and area.  The following is a very general overview of 
what may be considered sensitive.  This is in no way a definitive list. 
 
 
Personal Identifiable Information 
 
Personal Identifiable Information (PII) should be considered sensitive in almost all cases.  Things 
that constitute PII include: name, address, phone number, and social security number. 
 
 
Information Protected by Regulation 
 
This includes items such as that protected under FERPA and HIPAA.  Consult management in 
your department to help determine what information is protected by law.  If you are unsure, 
consider the data sensitive. 
 
 
Sensitive in Context 
 
Some information is innocuous by itself, but when included with other data becomes sensitive.  
For example a pin number or account number by itself, is just a number.  Together they grant 
access to a bank account.  A spreadsheet that contains account numbers and totals may not be 
sensitive, but that information in the context of an itemized budget may be something that should 
be protected.  
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What Should Be Protected? 
 
 

- Any data that is termed sensitive should be protected 
 

- Formulas 
 

- Any values that remain static 
 

- Any cells that show results from computations 
 

- Anything that may be changed by accident 
 

- Cells that users do not interact with 
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Spreadsheet Integrity Review 
 

INTRODUCTION 
 
Spreadsheets are used widely across the University for managing and reporting data for both 
financial and operational processes.  Many of the applications are large and complex.  Some 
spreadsheets are built and used by one user, while others have many users who modify or add 
data and change formulas and reporting formats.  The Sarbanes-Oxley Act of 2002 brought 
attention to the risks associated with the use of spreadsheets.  Of particular concern is the 
integrity of the information reported to management and external stakeholders.  
 
PriceWaterhouseCoopers published a white paper in 2004 entitled The Use of Spreadsheets: 
Considerations for Section 404 of the Sarbanes-Oxley Act.  In that document, they quoted an 
article in the May 24 2004 issue of Computer World that said, “Anecdotal evidence suggests that 
20% to 40% of spreadsheets have errors, but recent audits of 54 spreadsheets found that 49 (or 
91%) had errors, according to research by Raymond R. Panko, a professor at the University of 
Hawaii.” 

PURPOSE AND SCOPE 
Rather than auditing the detail of several specific spreadsheets, University Audits focused on 
developing a tool set that can be used across the University by users to improve spreadsheet 
controls.  While the tool set can be used on any spreadsheets, this review focused on spreadsheets 
that are large, contain sensitive data, or have multiple users. 
 
In order to understand and prioritize spreadsheet control risks, a sample of units was invited to 
work collaboratively with University Audits to assess spreadsheet controls in their areas.  
 
University Audits developed a self-assessment questionnaire to assist the selected areas in 
examining controls over their spreadsheets.  Area responses were used to further refine the 
questionnaire, create instructional documentation on securing spreadsheets, and create 
informational documents on spreadsheet security. 
 
The self-assessment questionnaire (located on page 8) addresses the following areas of 
spreadsheet controls: 

• User Access 
• Data Transmission 
• Documentation 
• Development 
• Segregation of Duties 
• Version Controls 
• Storage, Backup, and Recovery 

 
An overview of the findings in each of the control areas follows. 
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DISCUSSION 
 
User Access 
User access addresses the question of who can access a spreadsheet, and what they can do with it 
once they have access.  The self-assessment asked users to look at both the permissions on the 
spreadsheet file, and the folder that contains it.  The tool also addresses access within the 
spreadsheet by asking about locked and hidden cells.  The existence of file access logs is also 
examined. 
 
One method of controlling access to a spreadsheet is by locking the cells.  Locking cells prevents 
users from entering, deleting, or changing the information within the locked cell.  This will 
protect the spreadsheet from accidental and/or malicious changes.  On the whole, University 
Audits found that locked cells were not in wide use.  A few spreadsheets employed them with 
great success.  Instructional documents were created detailing the process of locking cells.  These 
instructional documents have been reviewed by the groups whose spreadsheet controls were 
examined, and in some places, implemented.  None of the areas examined were using 
spreadsheets that had cells restricted by user.  Most groups were unaware of this functionality.  
Instructional documents detailing the process for restricting cells were created and distributed for 
review to the areas examined. 
 
Access to spreadsheets can be controlled through the use of restrictive file permissions.  
Permissions on the files and folders were found to be excellent throughout.  Nearly all of the 
areas reviewed had created a directory structure based on job requirements.  This allowed them to 
restrict access at the folder level, without having to worry about access on individual files.  
 
File access logs can be used to find out which users accessed and/or changed a file, and when.  
This can be useful in tracking down the cause of a problem.  File access logs were not found to be 
in use.  This was not unexpected, and did not raise any concern.  Access logs are important for 
areas that have spreadsheets used by multiple users multiple times a day.  This was not the case in 
the areas we reviewed.  Each unit was encouraged to talk to their IT support team about access 
logs, whether they were appropriate for their environment, and if anything was currently being 
logged. 
 
Data Transmission 
Microsoft Excel has the ability to transfer information between individual worksheets within a 
workbook (spreadsheet), and between different spreadsheets.  While this can be a very useful 
feature, it also creates the opportunity for loss of data integrity.  University Audits asked the 
groups reviewed if they were transmitting data between, and within spreadsheets and what 
controls were in place to protect such transmitted data.  Excel’s ability to transfer data between 
spreadsheets was not found to be in wide use.  Only one of the areas reviewed was actively using 
it, and they were phasing it out.  This group has excellent managerial and group review practices 
in place to ensure data integrity.  
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Documentation 
Knowing what spreadsheets exist and what they are used for is the first step in determining how 
to secure them.  In the documentation section of the self-assessment, University Audits asked 
about spreadsheets being used, their purposes, primary users, and user permissions.  The self-
assessment document also addressed documentation of complex formulas along with their 
purpose and location. 
 
In most areas, documentation was found to be lacking.  Some groups had a tab within their 
spreadsheets with basic instructions for using the spreadsheet.  This is an excellent start but 
documentation needs to be strengthened.  Proper spreadsheet documentation is very useful in 
training new hires, audit reviews, and correcting data problems that may arise within the 
spreadsheets. 
 
Development 
The development section of the self-assessment focused on the creation of new spreadsheets.  It is 
important that a good process be in place for the development of new spreadsheets before they are 
brought into the production environment to ensure that they are error free and properly 
documented.  The self-assessment addressed the creation and updating of spreadsheets, and the 
creation of documentation, testing, managerial review, and replacing old versions of existing 
spreadsheets. 
 
Documentation of the development phase activities is not generally available.  Each group 
reviewed would assure a sound spreadsheet development environment by documenting 
expectations and spreadsheet development procedures.  Good testing and review practices are in 
place.  Old versions are moved or denoted as being out of date.  Most groups need to improve the 
creation of documentation. 
 
Segregation of Duties 
Many of the spreadsheets reviewed had one primary user.  In such cases, one person enters the 
data into the spreadsheet, performs the steps needed to process the data, and delivers the output.  
Concentrating these duties with a single individual creates a segregation of duties issue.  It allows 
that individual to accidentally or maliciously make inappropriate changes to a spreadsheet.  The 
self-assessment addressed the division of these key tasks among users. 
 
There was a low instance of segregation of duties issues.  In places where the duties could not be 
separated due to low staffing numbers, managerial review was recommended to mitigate the 
segregation of duties concern. 
 
Version Controls 
Because spreadsheets are heavily used for tracking (i.e. time, materials, schedules), multiple 
versions are frequently kept.  In order to ensure that all users are working with the most current 
production version, older versions need to be well controlled.  If possible these old versions 
should be modified to allow read only access to prevent someone accidentally using one to 
perform computations.  University Audits checked to see if all users were working with the most 
recent production version and how access was controlled; i.e., if access was being restricted, if 
ability to make changes was being restricted, and if a simple naming convention was employed. 
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Most of the groups had excellent naming conventions to assist them in identifying the most recent 
versions.  However, these areas generally were not segregating or restricting access to old 
versions.  A small percentage said that no steps are taken to ensure that all users are working with 
the most current version. 
 
Storage, Backup, and Recovery 
Spreadsheets often contain data that is integral to the way an office functions.  Sometimes this 
data is critical to business processes.  The importance of these spreadsheets makes good backup 
and recovery procedures essential.  University Audits reviewed departmental procedures to 
determine if: 

• Spreadsheets are regularly backed-up 
• Backup media is stored off site 
• Old versions are archived 

 
University Audits also asked participating units if spreadsheets were stored on local hard drives 
or removable media (such as thumb drives).  Those stored locally or on removable media are not 
normally backed-up properly.  Spreadsheets stored on network drives are usually professionally 
maintained and regularly backed-up.  Recovery procedures were examined to ensure that they are 
in place and regularly tested. 
 
All of the groups reviewed had good storage, backup, and recovery procedures in place.  All of 
them have this function taken care of by a University IT support group.  
 
 
SUMMARY 
Across the six groups reviewed by University Audits, we observed a wide variety of spreadsheet 
uses and purposes.  These groups provided a broad cross section of the University.  University 
Audits observed a number of excellent controls and control methods, and noted some control 
deficiencies.  These helped in building the documents that came out of this review.   
 
The tools created from this project will be made available to all groups across the University to 
help them better secure and control their spreadsheets and ensure data integrity.  



Hover over any business process cell for an explanation of the question.
* denotes items that you may need to ask your IT support staff about.

Category Business Process Yes No Partial Comments How-To Reference
1. Have user permissions been appropriately set 
on the directory the spreadsheet is housed in?* N/A
2. Have user permissions been appropriately set 
on the file itself?* N/A
3. Have access restrictions been placed on cells 
that contain formulas or perform computations?

Locking Cells in a 
Spreadsheet

4. Are file access logs being maintained?* N/A

5. Do you use locked cells?
Locking Cells in a 
Spreadsheet

6. Do you use hidden cells? N/A

7. Are hidden cells locked?
Locking Cells in a 
Spreadsheet

1. Does the spreadsheet send information to 
another worksheet, spreadsheet, program, or 
system? N/A
2. Does the spreadsheet receive information 
from another worksheet, spreadsheet, program, 
or system? N/A
3. Is sent or received information checked for 
accuracy? N/A
4. Is there a recurring managerial review of 
spreadsheets that send or receive data? N/A
1. Do you have a list of all spreadsheets in your 
department that contain sensitive information? N/A
2. Is the purpose of each spreadsheet included 
in this list? N/A
3. Are the users of each spreadsheet noted? N/A
4. Are their permissions noted? N/A
5. If the spreadsheet sends or receives data, is 
the source or destination noted? N/A

Spreadsheet Controls Self Assessment Tool

Data 
Transmission

User Access

Documentation
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Category Business Process Yes No Partial Comments How-To Reference
6. Do you have a master list of formulas used in 
spreadsheets with calculations? N/A
7. Is the location of each formula noted? N/A
8. Is the purpose of each formula noted? N/A
9. Are logs kept of changes made to the 
spreadsheet? N/A
1. When developing a new spreadsheet, is the 
new spreadsheet thoroughly tested before being 
brought into regular use? N/A

2. Is the new spreadsheet properly documented? N/A
3. Are there regular managerial review periods 
during development? N/A
4. Is there a managerial signoff on each 
completed component of new spreadsheets? N/A
5. If the new spreadsheet is replacing an older 
one, has the old one been archived on a secure 
drive? N/A
1. Does the same user input data, perform 
calculations, and output data? N/A

2. Do individual users have access to the cells or 
spreadsheets that control all of these functions?  

Restricting Cell 
Access by User

1. Are all staff members using the most recent 
version of their spreadsheets? N/A
2. Is a simple naming convention being used to 
tell an old version from the new one? N/A
3. Is access to old versions being restricted? N/A
4. Is the ability to update the version of a 
spreadsheet restricted?

Restricting Cell 
Access by User

1. Are your spreadsheets being regularly backed-
up?* N/A
2. Are copies of backups being stored off site?* N/A
3. Are spreadsheets being stored on local hard 
drives? N/A

Storage, 
Backup, and 
Recovery

Segregation of 
Duties

Version 
Controls

Development

Documentation
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Category Business Process Yes No Partial Comments How-To Reference
4. Are spreadsheets being stored on network 
drives? N/A
5. Are spreadsheets being stored on removable 
drives (USB hard drives, thumb drives, etc.)? N/A
6. Are old versions being archived? N/A
7. Are archives being securely stored?* N/A
8. Is a backup recovery procedure in place?* N/A
9. Are backup recovery procedures regularly 
tested?* N/A

Storage, 
Backup, and 
Recovery

10
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Spreadsheet Controls Self Assessment Tool Supplement 
 
* indicates items you may need to speak to your IT support staff about 
 
User Access 
 
1. Have user permissions been appropriately set on the directory the spreadsheet is housed in?* 
 
What you’re looking for is who is able to gain access to the directory that the spreadsheet is 
stored in.  Review the list of people who have access for anyone inappropriate.  Keep in mind that 
there may be users who do not need access to the spreadsheet, but do need access to other files in 
the directory.  In this case their access to the directory is appropriate. 
 
 
2. Have user permissions been appropriately set on the file itself?* 
 
This is where you address the issue of users needing access to other files in the directory, but not 
to your spreadsheet.  Review the list of users to make sure all are appropriate.  Also, look at their 
permissions (read, write, execute).  You may have some users with a need to see information kept 
in the spreadsheet, but no need to make any changes.  They should have read only access. 
 
 
3. Have access restrictions been placed on cells that contain formulas or perform computations? 
 
Normally you don’t want the formulas to change in your spreadsheet.  Cells that contain formulas 
should be locked to keep them from being accidentally, or maliciously, changed. 
 
 
4. Are file access logs being maintained?* 
 
Your IT department should have the ability to tell you who accessed a file, and when.  There are 
instances where this will not be appropriate (i.e., a spreadsheet accessed by many users constantly 
throughout the day).  The idea behind this is to be able to find out which account was accessing 
the file when something changed.  It will help track down accidental changes and inappropriate 
actions alike. 
 
 
5. Do you use locked cells? 
 
Locked cells can prevent unauthorized and accidental changes from taking place. 
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6. Do you use hidden cells? 
 
7. Are hidden cells locked? 
 
Hidden cells should always be locked.  They should be used sparingly as well.  Consider putting 
cells that are hidden on a different worksheet, or in a different file altogether.  It is easy to lose 
track of hidden cells. 
 
 
Data Transmission 
 
1. Does the spreadsheet send information to another spreadsheet, program, or system? 
 
2. Does the spreadsheet receive information from another worksheet, spreadsheet, program, or 
system? 
 
3. Is sent or received information checked for accuracy? 
 
Whenever you are sending or receiving information within spreadsheets, that data needs to be 
checked for accuracy.  There are a number of ways this data can be checked (managerial review, 
staff review, formulas that produce a predetermined result, etc.), and an appropriate one should be 
selected for your department.  
 
 
4. Is there a recurring managerial review of spreadsheets that send or receive data? 
 
Any spreadsheet that transmits data should be periodically checked for accuracy by a manager.  
Formulas in the spreadsheet should be checked against a list of what they are supposed to be.  
Sending test data though the system with known results to check for accuracy is a good idea as 
well. 
 
 
Documentation 
 
1. Do you have a list of all spreadsheets in your department that contain sensitive information? 
 
Keeping an inventory of what you have and where, will help you keep track of your spreadsheets.  
This will be extremely helpful during audits, upgrades, and new hire training. 
 
 
2. Is the purpose of each spreadsheet included in this list? 
 
Along with what and where, purpose should be included.  This will be helpful to have in an audit 
situation, and in training new employees. 
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3. Are the users of each spreadsheet noted? 
 
4. Are their permissions noted? 
 
A list of approved users for each spreadsheet that can be compared to actual users with access 
should be kept for audit and system recovery purposes.  Notes should be kept on users privileges 
(read/write) to the spreadsheet. 
 
 
5. If the spreadsheet sends or receives data, is the source or destination noted? 
 
This information should be kept so periodic tests can be easily performed.  You can also check 
this against where the spreadsheet says it is sending data. 
 
 
6. Do you have a master list of formulas used in spreadsheets with calculations? 
 
7. Is the location of each formula noted? 
 
8. Is the purpose of each formula noted? 
 
An accurate list of formulas used in your spreadsheets should be kept so that the spreadsheets can 
be periodically checked for integrity. 
 
 
9. Are logs kept of changes made to the spreadsheet? 
 
These should be kept so you have a record of the evolution of the spreadsheet, so changes that 
cause problems can be easily undone, and for recovery purposes. 
 
 
Development 
 
1. When developing a new spreadsheet, is the new spreadsheet thoroughly tested before being 
brought into regular use? 
 
Spreadsheets that you add into your production environment need to be added with absolute 
assurance that everything is right.  
 
 
2. Is the new spreadsheet properly documented? 
 
Documenting spreadsheets already in use can be a time consuming process.  Make sure that the 
items listed in the documentation section of this tool are addressed on new spreadsheets before 
they move into the live environment.  Keeping the documentation up-to-date is much less 
cumbersome than creating it. 
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3. Are there regular managerial review periods during development? 
 
Because spreadsheets are usually developed by either IT staff with little knowledge of your 
business processes, or by general business staff with little IT knowledge, it is important that 
management review the spreadsheet at regular periods.  This also can help prevent inappropriate 
additions to the spreadsheet that management is unaware of. 
 
 
4. Is there a managerial signoff on each completed component of new spreadsheets? 
 
Requiring a signoff on each phase of development helps to further ensure that the spreadsheets 
are being accurately and securely created. 
 
 
5. If the new spreadsheet is replacing an older one, has the old one been archived on a secure 
drive? 
 
Old spreadsheets should be archived and removed from their old storage space.  This will prevent 
users from accidentally using the old spreadsheet (out of habit) instead of the new one.  Storage 
spaces for old spreadsheets should be restricted. 
 
 
Segregation of Duties 
 
1. Does the same user input data, perform calculations, and output data? 
 
These duties need to be spread across multiple people whenever possible.  This protects the user 
from blame if something happens, and protects the data from intentional inappropriate changes. 
 
 
2. Do individual users have access to the cells or spreadsheets that control all of these functions? 
 
To ensure segregation of duties, users should be locked out of cells that they are not authorized to 
make changes in. 
 
 
Version Control 
 
1. Are all staff members using the most recent version of their spreadsheets? 
 
Out of sheer habit you may have staff members using older versions of a spreadsheet.  Ensure that 
all users are using the most current version of all spreadsheets.  This will help you ensure that the 
information you’re getting from them is accurate. 
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2. Is a simple naming convention being used to tell an old version from the new one? 
 
Using a date or version oriented file name can help users be sure that they are using the most 
recent version. 
 
 
3. Is access to old versions being restricted? 
 
Old versions of spreadsheets should be kept away from working versions.  Access to these files 
should be restricted. 
 
 
4. Is the ability to update the version of a spreadsheet restricted? 
 
Only authorized people should be able to make version updates.  This should be restricted to 
management level staff. 
 
 
Storage, Backup, and Recovery 
 
1. Are your spreadsheets being regularly backed-up?* 
 
Regular backups are important in case of file corruption or loss. 
 
 
2. Are copies of backups being stored off site?* 
 
Offsite storage is important in case of an incident in the building.  If there were a fire, local 
backups would be destroyed.  Having offsite storage help ensure your data can be recovered. 
 
 
3. Are spreadsheets being stored on local hard drives? 
 
4. Are spreadsheets being stored on network drives? 
 
5. Are spreadsheets being stored on removable drives (USB hard drives, thumb drives, etc.)? 
 
Spreadsheets with critical information should not be stored on local hard drives, or removable 
drives.  They should be kept on network drives (on servers).  Information stored on a local or 
removable drive is likely not protected, not backed-up, and vulnerable to theft.  
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6. Are old versions being archived? 
 
Old versions should be kept in an archive away from current ones.  This way they can be 
accessed if necessary, but will not be accessed on accident. 
 
 
7. Are archives being securely stored?* 
 
Archives should be kept on IT supported servers.  Backups of the archives should be kept off site 
as well. 
 
 
8. Is a backup recovery procedure in place?* 
 
9. Are backup recovery procedures regularly tested?* 
 
Backups are great, but if you can’t recover your data from them, they are useless.  
Comprehensive recovery procedures should be in place.  These procedures should be tested on a 
regular basis. 
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Keeping Column Headings Visible 

 
1. The command to do this is called Freeze Panes.  It freezes a row or column and 

everything above (row) or to the left (column) of it.  The first thing to do is decide what 
you want frozen. 

 
NOTE: This example demonstrates freezing a couple of rows.  The process for freezing 
columns is the same.  Any time “under” or “below” are used in the example, replace it with 
“to the right of” for performing a freeze on columns.  Also, any reference to the numbers on 
the left should be replaced by the letters at the top.  You can also freeze rows and columns 
simultaneously by selecting both and proceeding with the instructions. 
 
2. Once you have decided, select the row immediately below the one you wish to freeze.  

Do this by clicking its number on the left hand side.  The row you selected will now be 
highlighted across the entire page. 

 

 
 
  
3. On the View tab, in the Window group, click Freeze Panes. You now have three options. 

Click Freeze Panes to freeze the rows above the row you selected. Select Freeze Top 
Row to freeze row 1 only. Select Freeze First Column to freeze column A only.  
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4. When you scroll down now, everything above the selected row will stay in place.  To 
unfreeze your cells at any point click on the View tab, go to the Window group, click 
Freeze Panes, and select Unfreeze Panes. 

 

 
 
 
5.  Once you’re finished be sure to save your work.  
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Locking Cells in a Spreadsheet 
 

1. Identify which cells you want people to be able to change.  The cell locking feature in 
Excel locks everything by default, so you need to know which cells you don’t want 
locked first (i.e. cells for inputting data).  It is recommended that cells that contain 
formulas, cells that contain constants for formulas, and cells that contain results be 
locked.  

 
NOTE: once you protect a worksheet, rows and columns cannot be added unless the 
worksheet is unlocked first. 
 
2. Select the cells you want to be able to change. 
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3. Once you have selected the cells you want people to be able to edit, click on the Review 
tab, then click on Protect Sheet in the Changes group. 

 

 
 
 
4. A new window will pop up giving you a selection of check boxes.  Here you can select 

what users will be able to do to the locked cells.  This will not apply to the cells that were 
selected when we clicked on Protect Sheet.  Those cells will not have any restrictions 
placed on them.  It is recommended that you use the defaults unless you have an 
identified need to change them. 

 

 
 

 
5. Enter a password in the field at the top, and click OK.  This should not be a password you 

use for anything else, as you may have a need to share it later.  
 

NOTE: You do not have to enter a password.  However, if you don’t, the spreadsheet can be 
unprotected without the use of a password.  A password is recommended. 
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6. After you click OK, you will be asked to confirm the password you entered in a window 

that looks like this… 
 

 
 
 

7. You can also choose to protect the entire workbook from certain changes related to the 
layout and contents. To do this click on the Review Tab, and then click Protect 
Workbook in the Changes group. 
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8. Checking the structure box prevents users from adding or deleting worksheets or from 
displaying hidden worksheets.  Checking the windows box prevents users from changing 
the size or position of worksheet windows.  Workbook structure and window protection 
applies to the whole workbook.  It is recommended that you check both boxes in most 
cases. 

 

 
 
 

9. Once you have entered your password, click OK.  The protection windows will 
disappear. 

 
10. Be sure to save your document.  Your cells are now protected against unauthorized 

changes. 
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Restricting Cell Access by User 
 
Sometimes you need certain users to have access to cells that are generally locked.  Instead of 
requiring them to unlock the spreadsheet, you can tell Excel to let them access specific cells that 
are normally locked.  This way the spreadsheet stays locked, but allows the specified user to 
perform their task. 
 
This feature is available in Excel 2007. It can be accessed by going to the Review tab and 
clicking on Protect Workbook in the Changes group. The final menu item that drops down says 
Manage Credentials… 
 

 
 
 
This feature requires configuration of Information Rights Management (IRM).  You may 
encounter the message below if you try to enable it.  
 

 
 
 
IRM is designed to integrate with your Windows Active Directory environment. It will use 
Windows login information to authenticate users. Implementing IRM is best handled by your IT 
department. 
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Unlocking Spreadsheets 
 

1.  With the locked spreadsheet open, click on the Review tab, look in the Changes group, 
and click Unprotect Sheet. 

 

 
 
 
2. If there was no password set, then you’re done. 
 
3. If you do have a password set, a window will pop up that looks like this… 

 

 
 
 

4. Enter the correct password and click OK.  Your spreadsheet is now unlocked. 
 
 

After you make your changes, remember to lock the spreadsheet again and save it.  Saving in an 
unlocked state will leave the spreadsheet unlocked. 
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Preserving Data Integrity 
 
 
“Spreadsheets typically have a wide range of complexity and usage.  It is important to separate 
the complexity and usage issues, as the control requirements may be different for a complex 
spreadsheet used by one person with specific expertise than for a spreadsheet used and modified 
by many people.  Whatever the situation, companies need to carefully evaluate if it is possible to 
implement adequate controls over the spreadsheets supporting significant accounts and 
disclosures.  As some companies have discovered, errors in relatively simple spreadsheets can 
result in potential material misstatements in their financial results.  Recently, several large 
companies have either publicly disclosed control deficiencies or been publicly censured by 
regulators related to insufficient spreadsheet controls.1” 
 
 
 
 
“Even seemingly simple calculations may present the risk of a misstatement.  Macros (symbols, 
names or keys that represent a list of commands, actions or keystrokes) or other functions 
embedded into spreadsheets may drastically impact the functioning of the spreadsheet.  For 
example, a macro embedded into a spreadsheet designed to total invoices for recording an 
accounts receivable balance may add unsupported amounts to the balance.  Visual review of the 
spreadsheet would probably not identify the error, and analytical review would also not identify 
the error if the macro is consistently present across the periods under review.  Controls that may 
help mitigate these risks include access controls that limit which employees may view and update 
the spreadsheet, recalculation of key spreadsheet metrics and comparison to calculated values, 
and detail review and testing of calculations embedded in the spreadsheet.1” 
 
  

 
1 From PriceWaterhouseCoopers whitepaper on spreadsheets 
http://www.pwc.com/images/gx/eng/fs/insu/rt5.pdf 
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Helpful Links 
 
 
http://office.microsoft.com/en-us/excel/default.aspx 
 
http://www.exceltip.com/ 
 
http://www.microsoft.com/office/showcase/2007/sox/default.mspx 
 
http://www.infosecwriters.com/text_resources/pdf/SSSecurity_TOlzak.pdf 
 
 

http://office.microsoft.com/en-us/excel/default.aspx
http://www.exceltip.com/
http://www.microsoft.com/office/showcase/2007/sox/default.mspx
http://www.infosecwriters.com/text_resources/pdf/SSSecurity_TOlzak.pdf
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